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ABSTRAK

Website dapat menyajikan berbagai informasi mengenai profil perusahaan, profil lembaga pendidikan dan lain-
lain. Selain itu website juga biasa dijadikan sebagai media promosi yang hemat sekaligus menampilkan
profesionalitas. Sehingga dibutuhkan profesi webdesain dan Help Desk untuk membangun website yang
interaktif dan menarik, serta seorang ahli Help Desk dalam menangani kesalahan yang terjadi pada halaman. Ini
artinya bahwa terdapat sebuah peluang pekerjaan. Namun banyak sekolah yang belum menyiapkan bekal
siswa/i-nya ilmu tentang web desain dan Help Desk. Oleh karena itu, pada pengabdian kali ini siswa/l akan
diajarkan cara mengenalkan cara menjadi seorang webdesain dan Help Desk yang handal dalam mengahdapi
perkembangan teknologi saat ini. Metode yang digunakan untuk melakukan pelatihan ini dengan memberikan
langsung materi ke pada siswa/l SMK YPUI Parung dengan menggunakan perangkat komputer/laptop dan
jaringan internet. Untuk pencapain tujuan tersebut maka kegiatan pengabdian akan dilakukan secara langsung
dalam ruangan yang diikuti oleh 32 orang siswa. Adapun untuk membuat Web Desain yang harus dilakukan
adalah membuat white frame dan desain Ul dan UX dengan software AdobeXD dan dasar pengenalan Adobe
Photoshop. Selanjutnya untuk menjadi seorang Help Desk, yang harus dikuasai adalah problem solving,
memahami bisnis proses sebuah perusahaan. Dengan adanya pelatihan ini, siswa/l SMK YPUI mendapat
pengetahuan tentang cara membuat web desain dan dapat menjadi seorang heldesk yang profesional. Sehingga
setelah lulus dari sekolah dan ingin langsung bekerja, siswa/i dapat bersaing dengan yang lain.

Kata Kunci : Website; webdesain; Help Desk.

ABSTRACT

The website can present a variety of information about company profiles, profiles of educational institutions and
others. In addition, the website is also used as a media campaign that is sparing as well as displaying
professionalism. So it takes a webdesign and Help Desk profession to build interactive and attractive websites,
and a Help Desk expert in handling errors that occur on the page. This means that there is a job opportunity.
However, many schools have not yet prepared their students’ knowledge about web design and Help Desk.
Therefore, in this service students will be taught how to introduce a way to become a webdesign and Help Desk
that is reliable in dealing with current technological developments. The method used to conduct this training is
by giving material directly to students of YPUI Parung Vocational School by using computer / laptop devices
and internet networks. To achieve this goal, the service activity will be carried out directly in the room which is
participated by 32 students. As for creating Web Design, what needs to be done is to make a white frame and
design Ul and UX with AdobeXD software and basic introduction to Adobe Photoshop. Furthermore, to become
a Help Desk, what must be mastered is problem solving, understanding a company's business processes. With
this training, students of YPUI Vocational School get knowledge about how to make web design and can become
a professional Help Desk. So that after graduating from school and want to work right away, students can
compete with others.

Keywords: Website; web design; Help Desk.
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PENDAHULUAN

Website merupakan kumpulan beberapa halaman web dimana informasi digital dalam bentuk
teks, gambar atau grafis (format GIF, JPG, PNG, dll), suara (format AU, WAV, dll), dan objek
multimedia lainnya (MIDI, Shockwave Quicktime Movie, 3D World, dll) dapat ditampilkan dan
diakses oleh pengguna informasi tersebut. Representasi informasi tersebut pada suatu website
umumnya ditulis dalam bentuk hypertext melalui suatu bahasa yang dikenal dengan nama HTML
(HyperText Markup Language). Penerjemahan bentuk hypertext tersebut ke dalam bentuk yang dapat
dipahami manusia dilakukan oleh suatu perangkat lunak yang disebut sebagai browser. Website biasa
digunakan untuk berbagai kepentingan. Mulai dari untuk menjadi sisi wajah digital bagi institusi
resmi seperti lembaga pemerintahan atau badan usaha dalam menghadapi masyarakat pengguna jasa
atau produknya, hingga untuk keperluan aktualisasi individu dalam bentuk personal blog. Instansi
pemerintahan, mulai dari tingkat kementrian hingga ke tingkat desa. Website juga dapat menyajikan
berbagai informasi mengenai profil perusahaan, profil lembaga pendidikan dan lain-lain. Selain itu
website juga biasa dijadikan sebagai media promosi yang hemat sekaligus menampilkan
profesionalitas.

Help Desk pada dasarnya adalah sebuah center point dimana masalah atau issue dilaporkan dan
diatur secara terurut dan diorganisasikan. Dari perspektif umum, Help Desk merupakan bagian
pelengkap dari sebuah fungsi pelayanan, dan bertanggung jawab sebagai sumber dari pemecahan
masalah atau issue lainnya. (http://www.help-desk-world.com/help-desk.htm). Adapun tugas dari
seorang Help Desk diantaranya adalah mencatat, menyampaikan dan menangani permasalahan
(sesuai flowchart), membuat pelaporan / rekapitulasi penyelesaian permasalahan, menangani account
pengguna.

Untuk membuat web desain dan menjadi seorang Help Desk dibutuhkan suatu knowledge atau
kemampuan, setidaknya kemampuan dasar tentang bagaimana cara membuat web desain dan menjadi
seorang Help Desk. Hal ini sangat penting sebagai kemampuan dasar yang harus dimiliki untuk
melamar suatu pekerjaan. Di SMK YPUI Parung, di dalam matapelajaran prodi Teknik Komputer
Jaringan(TKJ) belum mempelajari tentang web desain dan Help Desk. Untuk itu perlu diadakan
pengabdian masyarakat berupa pelatihan Web Desain & Help Desk bagi siswa prodi Teknik
Komputer Jaringan (TKJ) pada SMK YPUI Parung kelas XII. Pelatihan ini dilakukan secara
langsung kepada siswa/i dalam ruang kelas dengan menggunakan perangkat komputer/laptop, infokus
serta jaringan komputer. Tahapan pelaksanaan dilakukan berupa pemberian pengetahuan tentang
dasar membuat web desain dan menajdi seorang Help Desk yang professional. Dasar membuat web

desain yaitu membuat white frame dan desain Ul dan UX dengan software AdobeXD. Sedangkan
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untuk menjadi seorang Help Desk yang profesional, hal dasar yang harus dikuasai adalah problem
solving dan memahami bisnis proses sebuah perusahaan. Dengan adanya pelatihan ini, siswa/i SMK
YPUI mendapat pengetahuan tentang cara membuat web desain dan dapat menjadi seorang heldesk
yang profesional. Sehingga setelah lulus dari sekolah dan ingin langsung bekerja, siswa/l dapat

bersaing dengan yang lain.

METODE

Kegiatan pengabdian kepada masyarakat ini dilaksanakan di sekolah SMK YPUI Parung,
Kabupaten Bogor, Jawa Barat. Peserta kegiatan pengabdian adalah kelas XI prodi Teknik Komputer
Jaringan(TKJ) sebanyak 32 orang. Kegiatan yang diadakan berupa pemaparan materi dan pelatihan
penggunaan aplikasi kepada siswa-siswi yang ada lokasi pengabdian/sekolah. Pemaparan materi dan
pelatihan penggunaan aplikasi yang dilakukan berupa ceramah, dilanjutkan dengan pemaparan
langsung berupa demo menggunakan laptop yang terkoneksi dengan internet agar siswa/i dapat
melihat bagaimana cara membuat web desain. Selanjutnya siswa akan diberikan sebuah modul yang
sudah disusun agar nantinya dapat digunakan. Kegiatan diakhiri dengan diskusi, tanya jawab, dan foto
bersama dengan siswa-siswi yang hadir pada acara tersebut.

Untuk mencapai tujuan yang telah dirumuskan sebelumnya, pelaksaan pengabdian masyarakat
ini dilakukan dalam beberapa langkah yang melibatkan metode penelitian lapangan, Penelitian
Pustaka dan Dokumentasi serta laporan. Langkah-langkah tersebut dilakukan dengan detail sebagai
berikut:

1. Penelitian lapangan
Dilakukan pengamatan dan wawancara dengan guru produktif TKJ dan siswa-siswi SMK YPUI
Parung jurusan Teknik Komputer Jaringan.

2. Penelitian pustaka
Langkah ini dilakukan dengan mempelajari berbagai sumber terkait perancangan website dengan
membuat white frame dan desain Ul dan UX dengan software AdobeXD, dan penanganan
(helpdesk) pada website.

3. Dokumentasi dan Laporan

Tahap ini berfokus pada pengumpulan bukti dan dokumentasi kegiatan pengabdian dan
menyusunnya menjadi laporan kegiatan pengabdian.
Keseluruhan waktu kegiatan pengabdian ini dilakukan selama 3 hari, yaitu dimulai dari tanggal

17 November 2019 hingga 19 November 2019. Tahapannya dapat dilihat pada tabel berikut:
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Tabel 1. Jadwal Pelaksanaan

Jenis Kegiatan Hari Pertama Hari kedua Hari ketiga

Pembukaan N

Pemberian Materi tentang Web Desain dan Help

Desk serta tanya jawab

\/

Pengenalan dasar dan Instalasi AdobeXD, N

Praktek membuat white frame dan desain

template untuk web serta tanya jawab

Penutup \

HASIL

Dari kegiatan pengabdian kepada masyarakat ini, menghasilkan beberapa hal yang sangat

bermanfaat bagi siswa/i SMK YPUI Parung, Bogor, yaitu:
1.  Web Desain

Web desain adalah jenis desain grafis yang ditujukan untuk pengembangan dan styling

obyek lingkungan informasi Internet untuk menyediakan dengan fitur konsumen high-end dan

kualitas estetika. Definisi yang ditawarkan memisahkan desain web dari pemrograman web,

menekankan fitur fungsional dari sebuah situs web, serta desain posisi web sebagai semacam

desain grafis. Web desain mempunyai keuntungan, yaitu:

a.

Siswa mampu menghasilkan website sendiri untuk berbagai keperluan

Ketika siswa sudah mempu menguasai dasar web desain dan mahir dalam mendesain sebuah
tampilan website maka siswa dianggap sudah mampu untuk mendesain web sesuai dengan
keperluannya, seperti saat membuka toko online maupun membuka website pengetahuan
tentang kesehatan maupun gaya hidup.

Membuka lapangan pekerjaan di bidang web design

Selain mampu membuat dan mendesain website pribadi, siswa juga bisa membuka lapangan
pekerjaan di bidang yang sama ketika banyak orang ingin menggunakan jasa web desain yang
sudah ada. Siswa bisa merekrut orang atau teman sekelas untuk membantu pekerjaan dalam
dunia web desain dengan nyaman.

Terhindar dari kejahatan dunia cyber

Ketika siswa sudah memahami karakter dari html, css, maupun program lain dalam sebuah

website, secara tidak langsung siswa juga akan terhindar dari berbagai kejahatan dunia maya.

Pengertian Help Desk
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Help Desk adalah bagian dari suatu perusahaan, yang memberikan solusi atau

menyelesaikan sebuah masalah yang dialami pelanggan atau pengguna baik itu dari pihak

internal (karyawan perusahaan itu sendiri) maupun eksternal (bukan karyawan perusahaan itu).

a. Help Desk memiliki peranan penting untuk perusahaan maupun masyarakat. Berikut adalah

kelebihannya.

Help Desk dapat meningkatkan kepercayaan pelanggan ke suatu perusahaan dalam
menangani pertanyaan dan keluhan pelanggan.

Help Desk dapat memecahkan masalah yang dialami pelanggan dalam waktu yang singkat.
Help Desk dapat mengatasi pertanyaan dan keluhan semua pelanggan karena pertanyaan
dan keluhan itu dicatat oleh Help Desk.

Help Desk dapat mengatur pembagian tugas kepada staff-staff perusahaan.

Help Desk dapat membuat sebuah laporan perkembangan kinerja para staff dan pimpinan.

b. Tujuan Dan Manfaat Help Desk

1)

2)

3)

Sebagai suatu konsepHelp Desk merupakan fasilitator untuk proses pemecahan
permasalahan operasional, melalui jaringan komunikasi dan interaksi , internal maupun
eksternal, antara sumber masalah (client) dengan potensi/kapasitas analisis pemecahan
masalah (expert) sehingga proses Asset Management menjadi lebih efektif dalam
peningkatan kinerja unit. Implementasi operasionalnya mengacu pada prinsip-prinsip
dalam konsep Knowledge Management.

Sebagai Suatu SistemHelp Desk adalah suatu jaringan kolaborasi dari berbagai pihak
terkait yang dikelola mengikuti prosedur dan mekanisme yang disepakati. Operasionalnya
didukung oleh infrastruktur: organisasi, tenaga ahli dan teknologi berbasis web, untuk
menunjang fungsi pemantauan serta proses pemecahan permasalahan secara on-line dan
real-time.

Manfaat Help Desk

o Kontinuitas pemantauan dan komunikasi on-line dan real time

o Fasilitasi kolaborasi pemecahan masalah

o Fasilitasi sinergi antar stakeholders

o Fasilitasi tenaga untuk assessment dan supervise

¢ Pembangunan data-bank (e-Library) permasalahan dan solusinya

c. Tugas — Tugas Help Desk

Mencatat, menyampaikan dan menangani permasalahan (sesuai flowchart)

Membuat Pelaporan/Rekapitulasi penyelesaian permasalahan
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Menangani account pengguna

d. Tingkatan Dalam Help Desk

Level 1 adalah untuk dukungan langsung yang ditangani oleh tingkat junior teknisi help
desk.

Level 2 menangani masalah yang tidak bisa diatasi oleh level 1

Level 3 adalah untuk panggilan yang tidak dapat diselesaikan dengan layanan telepon dan

memerlukan kunjungan oleh teknisi ke lokasi.

e. Macam — Macam Software Help Desk

Tivoli Service Desk

OTS (Open Ticket Support)

Aplikasi Web

Pugin Help Desk pada CMS (ZenDesk)

Membuat White Frame dan Desain Web yang Sederhana

Siswa diajarkan dasar-dasar membuat web desain, salah satu hasil dari prakter pengabdian

kepada masyarakat ini adalah sebagai berikut:

=

“®

Gambar 1. Tampilan Web Desain Dengan Adobe XD
sumber : (https://webdesign.tutsplus.com)

PEMBAHASAN
Dari hasil yang didapat, bahwa siswa/l SMK YPUI Parung telah belajar membuat sebuat web

desain sederhana dengan menggunakan aplikasi Adobe XD. Pembahasan ini akan menjelaskan cara
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membuat web desain yang sudah di praktekan oleh siswa/l SMK YPUI Parung. Cara membuat web

desain secara sederhana dengan AdobeXD, dapat dimulai dari cara menginstal adobeXD terlebih

dahulu, kemudian baru membuat project. Langkah-langkahnya adalah sebaga berikut:
1. Carainstall AdobeXD

Ada beberapa tahap yang harus dilalui sebelum menggunakan AdobeXD untuk membuat sebuah

desain web, yaitu sebagai berikut:

a.

Install Creative Cloud

Hal pertama sebelum memulai adalah download dan install terlebih dahulu Creative Cloud.
Karena saat ini, Adobe menggunakan fitur ini untuk menyimpan semua fitur-fitur pada
aplikasi Adobe. Jadi, Creative Cloud ini gunanya sebagai manager untuk beberapa aplikasi
yang kita gunakan dari Adobe. Sebagai misal, Adobe XD memiliki sebuah update terbaru
maka Creative Cloud akan memberikan sebuah notifikasi dan kita bisa langsung update pada
Creative Cloud tanpa mengunduh aplikasi Adobe XD lagi. Untuk mendownload aplikasi

Creative Cloud, bisa kunjungi website www.adobe.com/creativecloud, setelah itu bisa

langsung install. Karena ini adalah salah satu syarat untuk kita bisa meng-install aplikasi
AdobeXD.

Install Adobe XD

Setelah selesai install Creative Cloud (CC), kita akan melanjutkan untuk install Adobe XD
menggunakan CC ini. Sebelum ketahap selanjutkan, download terlebih dahulu AdobeXd pada

link www.adobe.com/sea/products/experience-design.html, dengan cara klik menu Download.

Tapi, disini diwajibkan menggunakan sistem operasi Windows 10 ataupun MacOS. Selain itu
OS tersebut, kita tidak akan bisa menikmati aplikasi ini. Setelah download, double klik pada
aplikasi AdobeXD. Akan muncul tampilan login, silahkan login (bisa menggunakan google,
facebook, atau email). Kemudian ikuti tahapan selanjutnya dengan mengisi form-form yang
diperintahkan, sampai muncul tulisan starting install. Disini AdobeXD akan ter-install,
pastikan internet yang digunakan dengan jaringan yang bagus. Jika sudah complete,
AdobeXD sudah dapat digunakan.

2. Membuat web Desain dengan AdobeXD

Menurut (https://webdesign.tutsplus.com) cara membuat sebuah situs untuk toko pakaian online

sederhana, sebuah merek fiktif yang disebut "Lo-key", yang menjual garis dasar bertema

kemerdekaan. Langkah-langkahnya adalah sebagai berikut:
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a. Memilih Ukuran Layar
Hal pertama yang diminta oleh Adobe XD adalah memilih ukuran layar. Default untuk web
adalah Web 1920 (1920 X 1080 px) tetapi Anda juga bisa mengambil salah satu dari pilihan
yang lain (Web 1280 atau Web 1366) atau memiliih ukutaran custom.

@

Design. Prototype. Share,

] T mis

iPhone 6/7/8 ~ Web 1920 Custom Size

Explore the basics.

Begin Tutorial : Open... 30

Gambar 2. Tampilan Membuat Ukuran Layar
Setelah Anda membuat pilihan Anda, Anda akan disambut oleh ruang kerja XD, dalam
tampilan Desain secara default, dan kanvas putih bersih ("artboard™) dalam ukuran pilihan
Anda.
b. Buat Duplikat Artboard

Kami akan membuat empat halaman standar untuk sebuah toko online:
1) sebuah home page.
2) sebuah halaman kategori ("'Shirts")
3) Keranjang (menunjukkan item yang telah ditambahkan pelanggan untuk pembayaran)
4) Halaman Tentang (yang memiliki sedikit informasi tentang merek)

Kami juga akan membutuhkan artboards untuk menu drop-down, serta pop-up yang
menampilkan lebih banyak rincian untuk produk yang dipilih (efek "lightbox™) tetapi kita
dapat membuatnya nanti. Untuk saat ini, buat tiga artboards lagi dengan memilih fungsi

artboard dari panel kiri dan klik di mana saja di samping artboard pertama Anda.
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Gambar 3. Tampilan Area Desain

Anda bisa, sebagai alternatif, juga klik artboard pertama untuk memilihnya dan pilih

Edit->Duplicate. Ubah nama masing-masing dengan mengetuk dua kali judul default

(terlihat di Kiri atas setiap artboard).

. Menempatkan Gambar Dan Menambahkan Teks

Untuk beranda kami, kami akan melakukan sesuatu yang cukup populer dengan situs
web di industri fesyen dan ritel. Kami akan memilih satu gambar besar untuk menjadi seluruh
latar belakang kami.

Tips : Anda dapat membiarkan Adobe XD mengetahui artboard beranda Anda dengan

memilih seluruh artboard dan mengeklik tag abu-abu yang muncul di sisi Kiri atas. Ini akan

menjadi biru untuk menunjukkan bahwa ini adalah halaman pendaratan atau halaman awal
untuk pengalaman Anda.

o Setelah Anda memutuskan pada gambar yang ingin Anda gunakan, pilih
File=> Impor (alternatif, tekan Cmd + Shift + I) untuk mencari gambar itu pada disk Anda
dan impor ke kanvas Anda. Jika gambar Anda lebih besar dari papan seni, tekan dan tahan
di atasnya, dan tarik ke sekeliling untuk menemukan posisi yang Anda suka. Melanjutkan
estetika minimalis kami, kami akan menjaga teks kami singkat dan bersih - hanya nama
merek (atau logo), tagline, dan bilah navigasi.

o Pilih alat Teks dari panel di sebelah kiri dan klik di mana saja yang Anda inginkan pada
artboard pertama untuk mulai menulis. Untuk teks logo kami, saya memulai di bawah
pertengahan tetapi Anda dapat memindahkannya ke tempat yang diinginkan dengan
mengeklik dan menyeretnya. Tentu saja, Anda juga dapat meng-impor gambar logo

dengan cara yang sama seperti kami mengimpor gambar latar belakang kami.
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o Di bawah teks logo, dapat menggunakan alat Teks lagi untuk menulis slogan merek Anda.

e Adobe XD menawarkan banyak pilihan pemformatan standar untuk teks Anda. Anda dapat
memilih blok teks apa pun dan mengubah font, gaya, warna, ukuran, dan atribut lainnya.

e Gunakan apa yang telah Anda pelajari di bagian ini untuk menambahkan judul halaman
untuk empat halaman yang tersisa dan tempatkan gambar dan teks isi untuk
halaman Keranjang dan Tentang.

d. Membuat Sebuah Simbol
Mari kita buka halaman About. Temukan ikon navigasi yang Anda sukai (seperti yang
ditemukan di set ini)dan letakkan di sepanjang logo, di sudut kiri atas, di

halaman About (atau salah satu dari dua halaman lainnya, selain halaman Beranda).

€« <« > 5> v 1 B O 0

7O m MmO 3 8 = O

Q ¢ B 0 8 = = =

Q¥ @ Q© © A @ @ = Lo-Key ABOUT
®© ¢ P A ¢4 &= th M@

T 2 v ¢ U DO OB

Wy 4 9 ® 6 o O

Gambar 4. Pilihan simbol-simbol dan hasil tampilannya

Karena membutuhkan ikon dan logo untuk laman lain juga, maka dapat mengubahnya
menjadi Simbol. Klik kanan dan pilih Make Symbol (atau tekan Cmd + K). Anda dapat
mengakses simbol apa pun yang Anda buat dengan mengklik ikon Aset di halaman Kiri. Dari
sana, Anda dapat menyeret dan menjatuhkan simbol ke salah satu papan luncur Anda. Dengan
cara ini, Anda tidak perlu menyalin-tempel setiap waktu. Anda dapat menghubungkan
simbol Lo-Key Anda ke halaman beranda menggunakan metode di langkah berikutnya.

e. Membuat Link Pertama

Beralih ke mode Prototype dari bar di atas. Perbesar papan art pertama Anda

(Beranda) dan pilih About Text. Panah biru akan muncul di sebelahnya. Tekan dan tarik

keluar. Kabel biru akan mengikuti dengan patuh ke mana pun kursor Anda pergi.

& XD File Edt Object View Window Help @ O F 2%E> ThudasPm Q @ =
eve

»

Gambar 5. Tampilan Prototype

110


https://elements.envato.com/vector-icon-set-SE677D
https://elements.envato.com/vector-icon-set-SE677D

JAMAIKA: Jurnal Abdi Masyarakat
Program Studi Teknik Informatika

Universitas Pamulang
Volume: 1 Nomor: 1
ISSN: 2716-4780

Seret ke papan seni kedua Anda (About) dan biarkan di sana. Anda kini telah membuat tautan
antara dua laman dan, memastikan tab Transition dipilih, Anda dapat memilih
jenis transition dan pelonggaran menggunakan munculan yang muncul saat Anda
menjatuhkan kawat. Untuk saat ini, Anda dapat mempertahankan transisi ke none karena
kami ingin halaman About untuk segera mengganti halaman rumah segera setelah
tombol About ditekan.

:
SHIRTS PANTS ABOUT

e B\ .
Gambar 6. Tampilan Untuk Menambahkan Tautan Ke Halaman Lain

. Gunakan Overlay untuk Menambahkan Dropdown Menu dan Lightbox

Sekarang, tambahkan menu tarik-turun navigasi kami. Buat papan seni baru,
berjudul Nav, dan ubah dimensinya menjadi persyaratan Anda menggunakan
kontrol Width dan height yang ditampilkan di panel kanan. Artboard Nav ditunjukkan di
bawabh ini adalah 210px X 275px. Menggunakan Teks dan, secara opsional, Line tool di panel
kiri, desain menu tarik-turun Anda. Menu ini akan muncul ketika pelanggan Anda mengklik
ikon hamburger.

Kembali dalam mode Prototipe, seret kawat dari menu hamburger ke papan seni Nav.
Di kotak yang muncul, alihkan ke tab Overlay. Kotak hijau akan muncul yang menunjukkan
di mana hamparan akan muncul. Seret untuk memindahkannya hingga berada di bawah menu
hamburger Anda. Pilih None sebagai pengaturan transisi Anda (atau bereksperimen dengan
opsi lain).

Sekarang klik ikon Play di jendela kanan atas. Halaman rumah Anda akan muncul di
jendela pratinjau. Klik tombol About untuk menuju ke halaman About. Sekarang, klik ikon
hamburger. Ini akan memunculkan menu drop-down Anda. Klik lagi dan itu akan hilang.
Anda dapat menghubungkan item / judul halaman di drop-down ke halaman masing-masing
menggunakan metode yang sama seperti pada Langkah 6. Ini akan mengubahnya menjadi

navigasi yang berfungsi untuk semua halaman dalam prototipe Anda.
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g. Gunakan Fitur “Ulangi Kotak” untuk Membuat Baris dan Kolom Objek

Untuk halaman Shirts kami, kami membutuhkan beberapa baris produk. Untuk itu, kita
akan menggunakan fitur XD yang disebut Repeat Grid. Jika desain Anda melibatkan
elemen berulang atau daftar konten, fitur Repeat Grid memungkinkan Anda melakukan itu
sembari tetap membuatnya mudah untuk melakukan perubahan yang memperbarui secara
otomatis di seluruh grid.

Gunakan Rectangle dari panel kiri untuk menggambar persegi panjang 450px x 300px dan
kemudian gunakan Fill dari panel kanan untuk mewarnai warna abu-abu terang untuk
menunjukkan ini adalah placeholder gambar.

Sekarang pilih persegi panjang dan klik pada Repeat Grid di panel kanan (atau Object>
Repeat Grid). Garis hijau dan slider hijau akan muncul di sekitar pilihan Anda,
memungkinkan Anda untuk memperluas daftar konten Anda ke segala arah (baik vertikal
dan horizontal dalam kasus kami). Untuk saat ini, klik dan seret cukup panjang untuk
membuat dua baris dengan tiga kolom masing-masing.

Pilih kisi ulang Anda dan kemudian arahkan pada ruang putih di antara persegi panjang
Anda. Saat berubah menjadi merah muda, Anda dapat menyeret ke atas dan ke bawah
untuk mengubah padding antar sel.

Untuk mengisi grid Anda dengan gambar produk, seret foto produk Anda dari satu folder
ke grid Anda di XD. Mereka akan mengisi grid secara otomatis.

Anda dapat menggunakan metode overlay yang sama dari Langkah 7 untuk membuat

lightbox produk Anda yang muncul saat Anda mengklik kaos / produk.

h. Langkah Opsional : Bagikan

Adobe XD memungkinkan Anda dengan cepat dan mudah membagikan apa pun yang
Anda kerjakan dengan kolaborator dan pemangku kepentingan lainnya. Jika Anda sedang
mengerjakan aplikasi atau situs web untuk klien, Anda dapat membagikan tautan ke
proyek desain Anda dengan mereka dengan memilih File> Share> Publish Prototype.

w% v O » M

Publish Design Specs

Manage Published Links...

Gambar 7. Tampilan Publish Prototype
Anda juga dapat mempublikasikan Spesifikasi Desain yang memungkinkan pengembang

(atau siapa pun dalam hal ini) untuk melihat pemformatan dan pengaturan lain untuk
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prototipe Anda di browser. Mereka juga dapat mengunduh aset apa pun, seperti gambar
atau grafik, yang Anda tandai untuk diekspor (masuk ke View> Layers. Anda dapat
memilih item apa saja dan mengklik ikon di sebelahnya, atau, klik kanan pada item apa
pun dalam daftar dan pilih Mark for Batch Export).

e Dan selesai. Anda sekarang telah merancang prototipe untuk toko online sederhana. Ini
dapat dibagikan dengan pemangku kepentingan, atau dipilih dan dibangun oleh
pengembang.

Dari hasil praktek pengabdian ini, siswa/l SMK YPUI Parung sangat berantusias untuk
memprakteknnya dan mempelajarinya lebih lanjut lagi. Mereka juga sangat puas dan sangat
terbantu dengan adanya pelatihan ini. Dari pihak sekolah pun mengharapkan tidak hanya tentang web

desain yang dijadikan pelatihan, tapi tentang teknologi dan aplikasi yang lain.

e

.....

Gambar 9. Tim Pengabdian dan Peserta PKM

SIMPULAN

Adapun kesimpulan yang bisa ditarik dari pengabdian kepada masyarakat ini adalah sebagai
berikut:
1. Siswa-siswi SMK YPUI Parung jurusan Teknik Komputer Jaringan telah mendapatkan ilmu

pengetahuan mengenai dasar pembuatan desain web.
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2. Siswa-siswi SMK YPUI Parung jurusan Teknik Komputer Jaringan bisa lebih kreatif dan inovatif
dalam membuat halaman desain web.
3. Siswa-siswi SMK YPUI Parung jurusan Teknik Komputer Jaringan dapat mengtahui tentang

penanganan kesalahan pada halaman web dan troubleshooting.
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